
Windows
Macintosh

p. 10
p. 52

• This guide explains how to install the software programs and 
briefly introduces their functions and operating procedures. 

• Please read the software license agreement in this guide before 
using the software. By using the software, you agree to be 
bound by the terms of the agreement. 

Software Starter Guide
(For the Canon Digital Camera Solution Disk Version 12)
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You must install the software bundled on the Canon 
Digital Camera Solution Disk before connecting the 
camera to the computer.

Install the software. Connect the camera 
to the computer.



The precautions noted within this guide are intended to instruct you in the safe and correct use of 
the products and to prevent injuries or damage to yourself, other persons and property. Please 
read and ensure that you understand them before proceeding to other sections of the guide. 

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.

• ArcSoft, the ArcSoft logo, ArcSoft PhotoImpression and ArcSoft VideoImpression are trademarks 
or registered trademarks of ArcSoft, Inc.

• Adobe is a trademark of Adobe Systems Incorporated.

• CompactFlash is a trademark of SanDisk Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer 

Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows logo are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.

• Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape 
Communications Corporation in the United States and other countries. Netscape Communicator 
is a trademark of Netscape Communications Corporation.

• Other names and products not mentioned above may be registered trademarks or trademarks of 
their respective companies.

Copyright © 2003 Canon Inc. All rights reserved.

SAFETY PRECAUTIONS

Warnings This symbol indicates topics that could lead to death or serious injury if 

ignored or handled incorrectly.

Warnings
• Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-

ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the 
speakers. It is also possible to suffer from hearing loss from listening with headphones to 

the loud sounds of a CD-ROM played on a music CD player.Disclaimer

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is 

accurate and complete, no liability can be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior 
written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards 
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.
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Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN 
THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS 
AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE 
DATA) AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND 
PROMPTLY RETURN THE SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and 
conditions of this Agreement.

1. LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a 
single computer. You may physically transfer the SOFTWARE from one computer to another 
provided that the SOFTWARE is used on only one computer at a time. You shall not install or use 
the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

With respect to the sound and image data (“Data”) contained in the Software, which are to be 
downloaded to the applicable Canon digital camera product, Canon grants you a personal, non-
exclusive license to use the Data on a single Canon digital camera product only.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE 
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING 
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE 
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and 
retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation of 
this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be 
responsible for providing maintenance or support for use of the SOFTWARE. No updates, fixes or 
support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON 
AN “AS IS” BASIS AND WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM 
storing the SOFTWARE is warranted only against defective material under normal use for a 
period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by your 
sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same 
without charge when returned by you at your expense to your point of purchase and proven to 
be defective upon inspection. The Replacement CD-ROM will be warranted for the remainder of 
the original ninety (90) day warranty period of the defective CD-ROM. The limited warranty does 
not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of the 
SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR 
CONDITIONS, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE 
SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.

READ CAREFULLY BEFORE USING
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NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OF IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH 
RESULTING FROM NEGLIGENCE ON THE PART OF THE SELLER, SO THE ABOVE 
DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO YOU.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), 
consisting of “commercial computer software” and “commercial computer software 
documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 
C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.72024 (June 1995), all U.S. Government 
End Users shall acquire the SOFTWARE with only those rights set forth herein. Manufacturer is 
Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and 
regulations of the country involved, and not to export or re-export, directly or indirectly, the 
SOFTWARE in violation of any such laws and restrictions and regulations, or without all necessary 
approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court 
or tribunal of competent jurisdiction, such provision shall be null and void with respect to the 
jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall 
remain in full force and effect.

9. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

10.OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the 
SOFTWARE is subject to the laws of the United States, and Canada, and other applicable 
copyright and trademark laws, and nothing in this Agreement constitutes a waiver of the rights 
of Canon, its affiliated corporations and third party licensors under such laws. You only own the 
CD-ROM media in which the Software is stored. Except as expressly provided herein, no license 
or right, express or implied, is hereby conveyed or granted by Canon to you for any intellectual 
property of Canon. Nothing contained in Paragraph 1 shall be construed to give Canon any 
ownership rights in any images, graphics or textual material that you save in connection with the 
Software. 

You may not modify, remove or delete any or all copyright notices (i) which are contained in the 
Software, including any copy thereof, and (ii) which are on the original CD-ROM and on the 
medium of a back-up copy made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE 
AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING 
THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR 
AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN 
THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS 
AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF 
CANON.
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Read This First

This chapter explains what you can accomplish using the camera with the 
software contained on the Canon Digital Camera Solution Disk. 

It also lists the computer system configurations required to use the software.

About this Guide
•The explanations in this guide are based on Windows XP and Mac OS X 

v10.2. If you are using another version of these operating systems, the 
actual screen contents and procedures may vary slightly from those shown.

•This guide uses the following notations on the right to represent the items 
on the left. 
Mac OS X (v10.1/10.2) -> Mac OS X 
Mac OS 9.0 - 9.2 -> Mac OS 9
CF Card, SD Card, PC Card -> Memory Card



It’s so Simple! Make Prints Right at Home Like a Pro2

It’s so Simple! Make Prints Right at Home 
Like a Pro 

See your Camera User Guide for shooting instructions.

Just install the software once at the beginning.

Shoot the images

Install the software on the 
computer
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Download images to the computer

Print the images

Connect the camera to the computer



Unbounded Possibilities with Entertaining Software4

Unbounded Possibilities with Entertaining 
Software

Print a Variety of Layouts
Print with the diverse layouts available in PhotoRecord (Windows) and 
ImageBrowser (Macintosh).

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch. 

The examples shown are from 

PhotoRecord (Windows).
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Send an Image as an E-mail Attachment
Attach an image to an e-mail message by starting your mail software from 
within ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer
Release the camera’s shutter from the computer with RemoteCapture. The 
recorded image is saved directly to your computer.

Convert RAW Images
Use the File Viewer Utility to convert RAW-format images downloaded to the 
computer into standard photo formats, such as the TIFF and JPEG formats. It can 
make fine adjustments to the image quality and coloring during conversion. 
(RAW format images can only be recorded by select camera models.) 

Release the shutter from the computer.



About the CD-ROMs in Your Package6

About the CD-ROMs in Your Package

About the Supplied Software
In addition to the Canon Digital Camera Solution Disk, your camera may be 
accompanied by other CD-ROMs containing image editing software. Your 
choice of camera model will determine which disks are included.

See Information about Your Camera (p. 91) to read which disks are included 
with your model.

For a description of the features and installation procedures for the software 
on the CD-ROMs, see About the CD-ROMs in Your Package (p. 104). 
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System Requirements

Please install the software on a computer meeting the following minimum 
requirements.

Windows

OS Windows 98 (First or Second Edition)
Windows Millenium Edition (Windows Me)
Windows 2000
Windows XP (Home Edition, Professional)

Computer Model The above OS should be pre-installed on computers with built-
in USB ports.

CPU Windows 98/ Windows Me/ Windows 2000: Pentium 150MHz 
or better
Windows XP: Pentium 300 MHz or better

RAM Windows 98/ Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ZoomBrowser EX: 120 MB or more 

(Including the PhotoRecord printing program)
- File Viewer Utility: 100 MB or more
- PhotoStitch: 40 MB or more
- RemoteCapture: 20 MB or more

•Canon Camera TWAIN Driver: 25 MB or more
•Canon Camera WIA Driver: 25 MB or more

Display 800 x 600 pixels/ High Color (16 bit) or better is required
1,024 x 768 pixels or better is recommended

•A CD-ROM drive is required to install the software.   
•A sound card is required to play movie audio tracks.
•All procedures performed with a connection to a USB 2.0 

compliant board are not guaranteed.



System Requirements8

Macintosh

OS Mac OS 9.0 - 9.2, Mac OS X (Version 10.1/ 10.2)

Computer Model The above OS should be pre-installed on computers with built-
in USB ports.

CPU PowerPC

RAM Mac OS 9.0 - 9.2: 20 MB or more of application memory
Mac OS X (Version 10.1/ 10.2): 128 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ImageBrowser: 50 MB or more 
- File Viewer Utility: 100 MB or more
- PhotoStitch: 30 MB or more
- RemoteCapture: 15 MB or more

•USB Mounter: 5 MB or more

Display 800 x 600 pixels/ 32,000 Colors or better is required
1,024 x 768 pixels or better is recommended

•A CD-ROM drive is required to install the software. 
•ImageBrowser, File Viewer Utility, PhotoStitch and 

RemoteCapture are compatible with Mac OS X (v10.1/10.2). 
However, they are not compatible with disks formatted with the 
Unix File System (UFS).

• All procedures performed with a connection to a USB 2.0 
compliant board are not guaranteed.
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Using the Software on the Windows 
Platform

- Preparations -

This chapter explains the basic procedures for installing the software and 
connecting the camera to a computer. Read this material before you connect 
the camera to the computer.



Installing the Software and USB Driver10

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

•Your computer
•Canon Digital Camera Solution Disk supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT 
connected to the computer. If it is, 
disconnect it and the cable from the 
computer.

2 Close any programs that are 
running. 

3 Place the Canon Digital Camera Solution 
Disk in the computer’s CD-ROM drive.

The installer panel will display automatically. 

If the installer panel does not appear 
automatically, use the procedures in How to 
Display the Installer Panel on the next page. 

•You must install the software before you connect the camera to 
the computer. 

•Users of Windows XP Professional and Windows 2000 must first 
log in as an Administrator (computer system administrator) to 
install programs. 
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4 Click [Software Installation].

5 Click [Next].

6 Read the software license agreement and click [Yes] if you consent to 
all the conditions.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not 
appear automatically.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe]  icon.

Windows 2000, Windows Me, Windows 98
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe]  icon. 
(Some computers may not display the [.exe] file name extension as 
shown above.) 

Installer Panel



Installing the Software and USB Driver12

7 Select your camera model name and click [Next].

Just click [Next] if your camera model name does not appear in the list.  

8 Confirm the installation destination and click [Next].

9 Select the programs you wish to install and click [Next].

Confirm that there is a check mark beside the names of the programs you 
wish to install.

The USB Driver (the software for connecting) is required 
when the camera is connected to the computer with a USB 
cable. Ensure that you select a USB driver from below (the 
appropriate one for your operating system). 
• Windows XP: no driver required for some models*
• Windows 2000:Canon Camera TWAIN Driver 
• Windows Me:Canon Camera WIA Driver  
• Windows 98:Canon Camera TWAIN Driver

*  The Canon Camera WIA Driver is required for Windows XP 
with the PowerShot G3, PowerShot S45 and PowerShot 
S230 DIGITAL ELPH/DIGITAL IXUS v3 models. 

Place a check mark 

beside your camera 

model name.

Installation destination
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13

10 Review the installation settings and click [Next].

The installation will start. Follow the onscreen instructions to proceed.

11 Click [OK] if the following message appears. 

This message will display if you selected and installed the USB Driver in Step 
9.

The items displayed here 

differ according to the 

software installed.



Installing the Software and USB Driver14

12 When the installation is over, select [Yes, I want to restart my 
computer now.] and click [Finish].

13 Remove the disk from the CD-ROM drive 
when your normal desktop screen appears 
after restarting.

This concludes the software installation. 
Continue by connecting the camera to the 
computer so that the USB Driver can be 
utilized.

Users of Windows XP Professional and Windows 2000 must 
log in as an Administrator (computer system administrator) 
after restarting to carry out the subsequent procedures. 

If you installed a USB Driver, so far the required files have 
only been copied to your computer. You must now connect 
the camera to the computer with the USB cable to complete 
the installation and prepare the driver for use. 

See Uninstalling the Software (p. 110) to delete the software 
installed with these procedures.
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14 Attach the camera to the computer and set it to the correct mode for 
connecting.

The USB Driver will automatically finish installing onto the computer when 
you attach the camera and open a connection. Dialogs similar to the 
following ones will appear during this process (first connection only).

Windows XP 
The following dialog will appear after a few moments and the USB Driver 
will automatically install.

Windows 2000/Windows Me/Windows 98 
The "Add New Hardware Wizard" will appear after a few moments and 
the USB Driver will automatically install. 

Restart the computer according to the instructions if you are prompted to 
do so by a message.

The Events dialog will appear after installation, allowing you to select an 
application to start. The explanation for these procedures is contained in 
Using the Software on the Windows Platform-The Basics (p. 17).

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 

•The USB Driver selected in Step 9 will automatically install if 
you are using a PowerShot G3, PowerShot S45 or PowerShot 
S230 DIGITAL ELPH/DIGITAL IXUS v3.

•A USB driver supplied with the Windows operating system 
will automatically install if you are using a camera other 
than one of the above models. 

The USB Driver selected in Step 9 will automatically install. 



Installing the Software and USB Driver16

This concludes the software and USB Driver installation and the procedures for 
connecting the camera to the computer.
You may now download camera images to the computer (p. 22). 

•See USB Driver Installation not proceeding well in the 
Troubleshooting section (p. 117) if you are having problems 
installing the USB Driver.

•See Uninstalling the USB Driver (p. 111) to delete the USB 
Driver installed with these procedures.

•See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 
125) if you were previously using either version. 
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Using the Software on the Windows 
Platform

- The Basics -

This chapter explains the procedures for using ZoomBrowser EX to download 
the camera's images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software 
on the Windows Platform - Preparations - section. 



Starting ZoomBrowser EX18

Starting ZoomBrowser EX 

Begin by starting up ZoomBrowser EX. The startup procedures vary according to 
whether you are connecting the camera to the computer or using a memory 
card reader. 

Camera to Computer Connection

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital Terminal. Prepare the camera for communication 
with the computer.

A dialog (Events dialog) similar to that below will appear after a moment. 
Select the application program you wish to start from the list in this dialog.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 

If the above dialog (Events dialog) does not appear, start 
ZoomBrowser EX with the procedures described in If the 
Events Dialog Does not Appear on the next page.

Your camera model name 

or "Canon Camera" will 

appear here.

Select an application 

program here.
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2 Select [Canon ZoomBrowser EX] and click [OK]. 

ZoomBrowser EX will start and open its Camera Window. The camera 
images will display as thumbnails (tiny versions) in the Camera Window.

A dialog allowing you to select the camera model will 
display if a camera and a memory card reader are connected 
at the same time. Confirm that your model name or "Canon 
Camera" is displayed and click [OK].

If the Events Dialog Does not Appear
Use the following procedures to start ZoomBrowser EX and display the 
Camera Window.

1 Double-click the [ZoomBrowser EX] icon on the 
desktop.

2 Click [Camera & Memory 
Card] when ZoomBrowser EX 
starts.

3 Click [Browse & Download 
Images] in the next menu.

This will display the Camera 
Window. 

Camera Window

Thumbnail
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Next, download images to the computer (p. 22).

Memory Card Connection

1 Insert the memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling 
instructions.

2 Start ZoomBrowser EX.

Double-click the [ZoomBrowser EX] icon on the desktop.

A message asking whether you wish to continue the 
connection may appear after some camera models are 
connected to the computer. See Connection Confirmation 
Message Displays (p. 117) in the Troubleshooting section 
regarding this message.

Place the memory card in an 

adapter if required.
Insert the loaded adapter 

into the slot.
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3 Click [Camera & Memory Card].

4 Click [Browse & Download Images] in the next menu.

This will display the Camera Window. The memory card images will display 
as thumbnails (tiny versions) in the Camera Window.

Next, download images to the computer (p. 22).

•A selection dialog will appear if multiple memory card 
readers loaded with memory cards are connected or if a 
camera and memory card reader are connected. Select one 
of the devices and click [OK].  

•See Memory Card Folder Structure (p. 115) for information 
about memory card folder structures and file names.



Downloading Images to the Computer22

Downloading Images to the Computer

1 Click on images in the Camera Window that you wish to download. 

The background color of the selected images will change to orange.

2 Click [Download Image].

A Download Settings dialog allowing you to select the image destination 
folder will display.

If you are downloading images previously selected with the 
camera’s [Transfer Order] setting, click [Select] and select 
[Select Send Mark].

“RAW” displays on RAW 

image.

Thumbnail

The movie icon displays on 

movie thumbnails.
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3 Confirm the destination folder and click [OK].

At this point the Camera Window will close and the Main Window will 
open. The downloaded images will appear in the Main Window.

Continue by printing out an image (p. 25).

After step 3 is completed, the [Server Busy] window may 
appear. If this happens, click [Retry]. (p. 129)

Specify the destination folder 

for the image(s).

(You can change the destination 

folder by clicking [Browse] and 

selecting a new destination.)

Select [Create new folder] to 

create a new folder within the 

one specified above, and select 

a naming option.

Main Window
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Other Methods of Downloading Images to the Computer

* Windows XP 
Your camera uses a standard image transfer protocol called the Picture 
Transfer Protocol (PTP). With the PTP and Windows XP, all you need do is 
connect the camera to the computer with a USB cable to download images. 
It is easy using the Scanners and Cameras Wizard and other procedures. (You 
do not even need to install ZoomBrowser EX or the USB Driver.) However, 
there are some inconveniences and limitations to this downloading method. 
See the For Windows® XP and Mac OS X Users leaflet for details. 

See the Picture Transfer Protocol (PTP) Mode leaflet if you are using a 
PowerShot G3, PowerShot S45, or PowerShot S230 DIGITAL ELPH/DIGITAL 
IXUS v3. In addition, set the camera's transfer setting to [PTP] if you use this 
method to download with these models. 

* Windows Me (with the USB Driver installed)
It is easy to download images using the Scanners and Cameras Wizard or 
Windows Explorer. All you need do is connect the camera to the computer 
with a USB cable. (ZoomBrowser EX does not need to be installed.) However, 
you cannot download RAW format images or movies with these methods. 

See the Windows Help system for information about the Scanners and 
Cameras Wizard and Windows Explorer. 
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Printing Images

1 Click [Print] in the Main Window.

2 Click [Layout Print] in the next menu.

3 Click on the image(s) you wish to print and click the [Next] button at 
the window's bottom right. 

Movies cannot be printed.

The background color of the selected images 

will change to orange.
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4 Place a check mark beside the data you wish to include with the print 
(multiple selections are possible) and click [Finish].

The PhotoRecord printing utility will start and display the PhotoRecord Print 
Modes window.

5 Confirm that [Artwork/Layout album] is selected and click [Next].

A comment can be attached to an image by selecting it in 
ZoomBrowser EX, clicking [Properties] and typing the 
comment. 

•When you select "Artwork/Layout album", you can resize or 
reposition images freely for printing.

•The other print modes allow you to do such things as tile 
the images for printing or arrange them for printing on 
Canon perforated paper.

For example, you can print 

the shooting date and time 

with the image if you select 

[Date and Time] here.
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6 In the next window, set the paper size and the other settings and 
click [Next].

7 In the last window, select [Automatic layout] and click [Finish].

This will display the PhotoRecord window. 

8 Click the PhotoRecord [Print] button.

This will display the Print dialog.
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9 Click [Print] to start printing.

This concludes the image printing process.
This chapter explained the ZoomBrowser EX basics. Once you have 
mastered them, read the following chapter to try the advanced techniques.
Using the Software on the Windows Platform - Advanced Techniques (p. 
29) 

•The Index Print Settings dialog will open if you select [Index 
Print] in Step 2 and complete steps 3 and 4. You can select 
the settings, such as the thumbnail size and paper size, and 
click [Print] to start an index print.

•Images shot with Exif 2.2-compliant cameras (Exif Prints) 
incorporate information about the shooting settings, such 
as the camera modes and settings. Better prints can be 
made by using this information to correct the image. 
To correct image quality, right-click an image and select 
[Clip/Correct Photo] from the pop-up menu. Place a check 
mark beside [Exif Print] or [Photo Optimizer Pro] in the next 
window and click [Close] to have it corrected. You should 
obtain better results when the image is printed.

A PDF-format manual for ZoomBrowser EX is also available. 
It provides further information about the program's features 
and procedures. See Using the PDF Manuals (p. 109).
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Using the Software on the Windows 
Platform

- Advanced Techniques -

This chapter explains various ZoomBrowser EX features, such as how to play 
movies, create panoramic images and operate the camera shutter from the 
computer.

Proceed to this chapter once you have mastered the basic ZoomBrowser EX 
procedures in the Using the Software on the Windows Platform - The Basics
chapter.
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The ZoomBrowser EX Windows

ZoomBrowser EX has two windows: the Camera Window and the Main 
Window. This topic explains the features of these two windows. 

Camera Window

This window can be used to view images in the camera (or memory card) and 
download them to the computer. 

Only the rotated image is saved to the computer with the 
following camera and image settings. (RAW images, however, 
are downloaded in the correct viewing orientation with the 
rotation data intact.)
•When the camera's [Auto Rotate] function is set to [On] (a 

function that displays images shot in portrait orientation in the 
correct orientation for viewing)

•When JPEG images are rotated with the manual rotation 
settings

•When JPEG images are rotated in the Camera Window
To download both the pre-rotation and post-rotation images, 
click the [Tools] menu in ZoomBrowser EX's Main Window and 
select [Preferences], followed by the [Rotate] tab. Place a check 
mark beside [Rotate a copy of the JPEG image].

The images from the camera (or 

memory card) display here.

Function Buttons

These buttons apply functions to images 

selected in the Camera Window.

Task Buttons

These buttons 

select the task 

to carry out.

A window allowing you to specify the download 

destination opens when you select images and 

click the [Download image] button
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Main Window

This window can be used to organize the images downloaded to the computer. 
It can also be used for other purposes, such as printing images and attaching 
them to e-mail messages.

Folders Area

Select image folders here. As in Windows 

Explorer, you can view the contents of 

the folders.

Task Buttons

These buttons select 

the task to carry out.

Browser Area 

Displays the images contained in the 

folder selected in the Folders area. 

Double-clicking an image shows it at a 

larger size.

Function Buttons

These buttons apply functions to 

images selected in the Browser 

Area.
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Replaying Movies

When you double-click an image with a movie icon in the ZoomBrowser EX’s 
Browser Area, QuickTime Player will start and replay the movie. 

1 Double-click an image with a movie icon. 

QuickTime Player will start. 

2 Click the play button  in QuickTime 
Player.

The movie will replay.

Do not double-click a movie file (.AVI extension) in the Windows 
Explorer to play it. That will start Windows Media Player, which 
may not support this file type. To replay movies, use 
ZoomBrowser EX as instructed above, or if you are using 
Windows Explorer, start QuickTime Player first and open the file 
from within the program. 

Installation Procedures for QuickTime
1. Set the Canon Digital Camera Solution Disk in the CD-ROM drive.

The installer panel will automatically appear. (Display it with the 
procedures in How to Display the Installer Panel (p. 11) if it does not 
appear.)

2 Click [QuickTime 5.0 Installation].

Follow the onscreen instructions to proceed with the installation.
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Converting RAW Images - File Viewer 
Utility

Images can be recorded in the RAW format (RAW images) with certain camera 
models. RAW images are extremely high-quality images that are not degraded 
by compression algorithms when recorded. However, they are not supported by 
most image editing programs in their native format, so they must be converted 
before use. 
Use the File Viewer Utility to convert RAW images.

Converting RAW Images

1 Click [View & Modify] in ZoomBrowser EX's Main Window and 
[Process RAW Images] in the next menu. 

2 Select a RAW image in the Browser Area and click [Finish].

The File Viewer Utility will start and display the selected RAW image in the 
list.

3 Perform image quality adjustments as required.

See Image Adjustment Features (p. 34) for instructions.

4 Click the [File] menu and select [Save File] and [Convert and save in 
file].

This will display the Save File dialog.

5 Select a file destination and format for the image you wish to 
convert.

You can save the image in the JPEG or TIFF format.

6 Click [OK].

The utility will start to convert the image and save it to the computer. 

•See Information about Your Camera (p. 91) to see if your camera 
supports the RAW format.

•See your Camera User Guide for the settings required to shoot 
RAW images. 
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File Viewer Utility Features

Image Adjustment Features

The following items will display when you select a RAW image and a camera 
model name in the Model-Specific Processing Mode list box.

Save Button

Converts and saves the image.

Preferences Button

Use this button to select 

image transfer 

applications. You can also 

use it to adjust RAW image 

processing settings.

Image Selection Button

Selects the method for selecting 

images.

Buttons for selecting images. 

Help Button

Displays help 

topics.

Version

Information

Button

Displays the 

program 

version 

information.

Displays a 

histogram 

(distribution

of brightness 

data) for the 

image.

Displays the 

image 

information

here.

Comment Box

A description of up to 60 

characters can be input here.

Display Mode List Box

Selects the thumbnail 

or preview display 

mode.
Display Size List Box

Selects the size at which images display.

This section displays when a camera model 

name is selected in the Model-Specific 

Processing Mode list box.

Click this button and then 

a white portion of an 

image to automatically 

adjust the white balance 

to that color. Adjusts the sharpness.

Adjusts white balance settings.

Sets the Photo 

Effect mode.
Adjusts image 

contrast.

Adjusts

image color 

saturation.

Model-Specific Processing Mode List Box

Selects the model of camera in use.
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Merging Panoramic Images - PhotoStitch 

You can create a wide panoramic image by merging several images, such as 
those shot in the camera's Stitch Assist mode.
Use the PhotoStitch program to merge the images.

Starting PhotoStitch 

Start PhotoStitch from ZoomBrowser EX.

1 Click [View & Modify] in the ZoomBrowser EX’s Main Window and 
[Stitch Photos] in the next menu.  

2 Select a series of images in the Browser Area and click [Finish].

A window similar to that below will appear.

3 Merge the images following the instructions in the guidance panel 
at the top of the PhotoStitch window.

•QuickTime 3.0 or a later version is required to save the 
merged image in the QuickTime VR format. (QuickTime is 
supplied on the Canon Digital Camera Solution Disk.)

•Images shot in Stitch Assist mode with a wide converter, 
teleconverter or close-up lens cannot be merged accurately. 

Follow the instructions 

to merge the images.
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Images Shot in Stitch Assist Mode 

It is easy to merge images shot with the camera's Stitch Assist mode since 
PhotoStitch automatically arranges them in the correct order and orientation.
Stitch Assist mode images appear in the Camera Window as shown below. 

•You can start PhotoStitch by clicking the mark shown on images 
shot in Stitch Assist mode.

•See the Camera User Guide for information about shooting in 
Stitch Assist mode.

Images shot in Stitch Assist mode display a mark 

like this. 
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Operating the Shutter Remotely - 
RemoteCapture

You can use a computer to control the shutter of a connected camera to record 
still images. This is particularly useful for checking images on the larger 
computer display as you record them. 
Start the RemoteCapture program to perform this task.

Starting RemoteCapture 

Start RemoteCapture from ZoomBrowser EX.

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal. Prepare the camera for communication 
with the computer.

2 Open the lens cover or remove the lens cap on models equipped 
with them. 

Proceed to Step 3 if your model does not have one.

3 Select [ZoomBrowser EX] in the dialog (Events dialog) that allows 
you to select an application program, and click [OK].

This will start ZoomBrowser EX and display its Camera Window.

4 Close the Camera Window.

This will open ZoomBrowser EX's Main Window.

5 Click [Camera & Memory Card], then [Remote Shooting] in the next 
menu.

This will start RemoteCapture.

6 Click [Connect] when the "Connect to camera?" prompt appears.

This will display the Shooting - RemoteCapture window.

Close the ZoomBrowser EX Camera Window before starting 
RemoteCapture.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 
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RemoteCapture Features

RemoteCapture has two windows: the Shooting-RemoteCapture window and 
the Save-RemoteCapture window. Use these windows to record and save 
images, respectively.

Shooting-RemoteCapture Window

RemoteCapture locks the exposure and focus settings for the 
subject matter in the Viewfinder section. If the lighting or 
distance to the subject changes, click [Reflect changes] to reset 
these settings.

Recordable Image Counter

Displays the number of images that will 

fit onto the computer or memory card in 

the camera.

Viewfinder Display

Click the [Viewfinder 

On] button while a 

connection to the 

camera is open to 

display the image 

appearing in the 

camera’s viewfinder. 

Viewfinder On/Off 

Button

Turns the viewfinder 

display on or off.
Reflect Changes Button

Updates the settings.

Slide this to zoom 

the camera in or out.

Set the basic camera 

settings here.

Release Button

Releases the 

shutter.

Detail Settings 

The Detail Settings 

dialog opens when 

you click the arrow 

symbol on the left.
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Save-RemoteCapture Window

The following limitations apply when the Viewfinder image is 
displayed with a DIGITAL ELPH/DIGITAL IXUS series camera.
•The Viewfinder will automatically turn off after you shoot or 

after 1 minute passes after it is turned on. Click [Viewfinder On] 
again to turn it back on. However, you may have to wait a 
moment for it to come back on if the camera body temperature 
has risen.

•The camera's LCD monitor does not display while the 
Viewfinder is on. In addition, the Video OUT settings cannot be 
set with RemoteCapture.  

Thumbnail View

Displays thumbnails of 

all the images shot after 

RemoteCapture is 

started. 

Connect/Disconnect Button

Click here to open a connection to the camera and 

display the RemoteCapture Shooting window. It will 

change to the Disconnect button while a connection is 

open. Click it to close the connection.

View Button

Displays images 

selected in the 

Thumbnail View 

area at a larger 

size.

Delete Button

Deletes images 

selected in the 

Thumbnail View 

area (completely 

from the computer).

Histogram

Check the distribution of 

brightness data here.

Image Information

Check the image settings here. 

Comments

Add a comment about the 

image here.

Image Display Area

Displays the image 

selected in the 

Thumbnail View.
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Shooting with RemoteCapture

1 Click the arrow to the left of [Detail Settings].

The full-view Shooting-RemoteCapture window will display. 

2 Click [Viewfinder On] and view the image in the Shooting-
RemoteCapture window.

Change the settings if required. To update any changes made in the Detail 
settings window, click the [Reflect changes] button.

3 Set the Size/Quality and Rotation settings in the Shooting-
RemoteCapture window. 

You can save images of people and other subjects that are shot in portrait 
orientation (camera held 90° on end) to the computer in the correct 
viewing orientation by setting the [Rotation] category to [90 degrees left] or 
[90 degrees right].

4 Click the [Release] button. 

Images shot with RemoteCapture are automatically saved to the folder 
selected in ZoomBrowser EX.

If your computer is set to go into standby mode, there is no 
guarantee that RemoteCapture will continue to function after 
the computer enters standby mode. Always turn off the standby 
function before you start shooting with RemoteCapture. 

•The rotation settings in RemoteCapture cannot be used if 
your camera is equipped with the Auto Rotate function and 
it is set to On.

•To change the destination of the saved image, see Changing 
the File Destination and Method of Saving (p.42).

•You can also release the shutter by pressing the camera's 
shutter button or the keyboard's space key.

•The zoom controls and other camera buttons and switches, 
except for the shutter button, cannot be operated while 
RemoteCapture is controlling the camera. 

•You may notice that the interval between the shutter 
release and activation is slightly longer when 
RemoteCapture is used to shoot than when the camera is 
used in the normal fashion. 
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Interval Timer Shooting

Interval timer shooting is a method of shooting that records a specified number 
of frames at set intervals. 

1 In the Shooting-RemoteCapture window, click the [Interval Timer 
Shooting] tab.

This will display the Interval Timer Shooting window.

2 Set the number of frames and the interval value and click [Start]. 

This will record the specified number of frames at the specified interval.

Timer Shooting

Timer shooting is a method of shooting that records a frame after a specified 
number of seconds.

1 In the Shooting-RemoteCapture window, click the [Timer Shooting] 
tab.

The Timer Shooting dialog will display. 

2 Set the timer interval and click [Start]. 

This will record an image after the specified time has elapsed.

•You can set the time interval between 5 seconds to 60 
minutes. 

•You can capture up to the number of recordable frames 
displayed in the Shooting-RemoteCapture window (the 
actual limit is 9999 frames when the displayed number is 
10,000 or higher).

Please note that the camera will not be able to shoot at the 
specified interval if it is shorter than the time required to 
transmit the data and save it to the computer.

You can specify a timer interval from 2 to 30 seconds.
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Other Features 

Changing the File Destination and Method of Saving
1 In the Save-RemoteCapture window, click the [File] menu and select 

[Preferences].

This will display the Preferences dialog.

2 Select the way images are saved and the folder to which they are 
saved and click [OK].

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor. 

1 In the Shooting-RemoteCapture window, click the [Camera] menu 
and select [Camera Display Settings].

The Camera Display Settings dialog will display.

2 Select [Camera LCD monitor] and click [OK]. 

3 In the Shooting window, click the [Viewfinder On] button. 

Selecting [Computer only] in the "Save Images On" category 
allows you to shoot when there is no memory card in the 
camera or when the camera's memory card is full.

Sets whether images are saved only to the 

computer or to both the computer and the 

memory card in the camera.

Input a root name for the image files here. If 

you input “Capture”, for example, the first 

image will be named [Capture_00001.jpg] 

and successive images will automatically be 

assigned a name that is one number higher 

than the last. 

Select a folder where images will be saved.

Select the drive on the computer where 

images will be saved.
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Printing an Index of the Thumbnail Images
You can print an index of all the thumbnails displayed in the Thumbnail View 
area of the Save-RemoteCapture window by clicking the [File] menu and 
selecting [Print Index]. This provides a convenient register and means of 
checking your images since the file name and shooting date are also printed 
with each image.

You can display the subject on a TV connected to the camera 
by selecting [Video Out terminal] in Step 2. See the Camera 
User Guide for instructions to connect the camera to a TV.
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Enjoy Customizing Your Camera with the 
My Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-
timer sound are called the My Camera Settings. You can add your favorite 
images and sounds from your computer to the My Camera Settings in the 
camera. This topic explains how to upload the My Camera Settings saved onto 
your computer to the camera. Use ZoomBrowser EX to perform this function.

Displaying the My Camera Window

To save the My Camera Settings to the camera, you use the My Camera 
window. The following explains the procedures for displaying the My Camera 
window. 

1 The Camera Window will open after you have connected the camera 
to the computer and started ZoomBrowser EX. 

For starting instructions for ZoomBrowser EX, see Starting ZoomBrowser EX
(p. 18).

2 Click [Set] in the Camera Window and select [My Camera] in the pop-
up menu.

Alternatively, you can click [Camera & Memory Card] in the Main Window 
of ZoomBrowser EX, followed by [My Camera Settings] to display the My 
Camera window.

Please check whether or not your camera model supports 
this function. See Information about Your Camera (p. 91) for 
details.
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The My Camera Window Features

Saving the My Camera Settings to the Camera

You can save the My Camera Settings displayed in the My Camera window to 
the camera. 

ZoomBrowser EX already contains several pre-recorded My 
Camera Settings items. You can check these items with the 
My Camera window.

•The Create Sound button is unavailable when you open the My 
Camera window from the Camera Window.

•You can add new data to the My Camera window. See Adding
New Data to the My Camera Window (p. 47). 

Tabs 

Click here to switch between adjusting the 

settings individually or in themed sets. If the 

[Set individually] tab is selected, the Data 

Type can also be selected.

Displays the list of My 

Camera Settings files 

saved onto the 

computer.

Add File Button

Click here to add a file 

as one of the My 

Camera Settings to 

the My Computer list.

Play Button

Click here to play the 

selected sound 

setting.

Delete Button

Click here to delete a 

setting from the My 

Computer list. 

Create Sound Button

Click here to create a sound file 

for use as the start-up sound, 

shutter sound, operation sound, 

or self-timer sound. 

Delete Button

Deletes a setting 

from the Camera 

list.

Displays the My 

Camera Settings 

in the camera.

Play Button 

Click here to play sounds recorded 

onto the camera. 
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1 Confirm that the [Setup as a theme] tab is selected in the My Camera 
window. 

To save the settings individually, select the [Set individually] tab and select 
the setting type in the [Data Type] list box. 

2 Select the settings file you wish to save to the camera from the My 
Computer list.

If you are working in the [Setup as a theme] tab, the thumbnail (tiny 
version) of the start-up image will display to the right and the sound files 
will play in the order of start-up sound, shutter sound, operation sound and 
self-timer sound. 

3 Select the setting from the Camera list that you would like to change 
and click [Save to Camera].

This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this 
category has previously been saved to the camera, it will be overwritten. 

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound 
settings on the camera itself. Please see the Camera User Guide for these 
instructions.

Saving the Camera’s My Camera Settings to the Computer

The My Camera Settings on the camera can be saved to the computer. 

•My Camera Settings can be selected and saved in either of two 
ways to the camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the 
start-up image and animals calls in each of the sound files. The 
names of the prepared files for the various My Camera Settings 
themes all begin with the same root name, such as “Animal~”. 
For example, the start-up image that starts with “Animal~” 
shows an animal picture while the similarly named sound files 
feature animal sounds.

•Settings that do not appear in the My Computer list of the My 
Camera window cannot be saved to the camera. 

•Do not detach the USB cable, turn the camera power off or 
disconnect the camera from the computer while the My Camera 
Settings are being saved to the camera or the settings from the 
camera are being saved to the computer. 
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1 Confirm that the [Setup as a theme] tab is selected in the My Camera 
window. 

To save the settings individually, select the [Set individually] tab and select 
the setting type in the [Data Type] list box. 

2 Select the settings file(s) from the Camera list that you wish to save 
to the computer.

If you are working in the [Setup as a theme] tab, the thumbnail (tiny 
version) of the start-up image will display to the right and the sound files 
will play in the order of start-up sound, shutter sound, operation sound and 
self-timer sound. 

3 Click [Save to PC].

This concludes the process of saving the My Camera settings to the 
computer.
Repeat steps 1-3 as required.

Adding New Data to the My Camera Window

To add new data to the My Camera window, you need to create it, save it to the 
computer and add that file to the My Camera window.

Create an Original Start-up Image File and then Add It
Start by creating the image file that will become the start-up image and save it 
to the computer. Use an image editing program, such as ArcSoft 
PhotoImpression. Create the file in the JPEG format at a size of (w) 320 x (h) 240 
pixels.
Once you have created the data and saved it to the computer, use the following 
procedures to add it to the My Camera window.

1 Open the My Camera window, click the [Set individually] tab, select 
[Startup Image] from [Data Type] and click the [Add File] button.

This will display the Open file dialog.

My Camera Settings can be selected and saved in either of two 
ways to the computer: individually or in theme sets.
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2 Select the file you created and click [Open].

The selected file will appear in the Computer list.
This concludes the process for adding new data.
You can save the newly created data to the camera using the procedures 
described in the Saving the My Camera Settings to the Camera section (p. 
45).

Create an Original Sound File and then Add It
The following example shows how to record and create a start-up sound file 
using the My Camera Sound Maker window.
QuickTime is required to play the recorded sound.

1 Click [Camera & Memory Card] in the Main Window of ZoomBrowser 
EX and select [My Camera Settings] in the next menu.

The My Camera Selection dialog will display.

2 Select [Start-up Image, Start-up Sound, Operation Sound, Selftimer 
Sound and Shutter Sound] and click [OK].

The My Camera window will display.  

3 In the My Camera window, select [Set individually], select a sound 
type in the [Data Type] and click the [Create Sound] button in the My 
Camera window. 

The My Camera Sound Maker window will display.

4 Click the tab of the sound file you will be creating, followed by the 
[Record] button. Click the [Start_up Sound] tab in this example.

To delete a setting, select the file name and click the [Delete] 
button at the bottom of the My Computer list.
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5 Click the [Start] button.

Recording will start.

6 When the recording is complete, click the [Stop] button, followed by 
the [Close] button.

Recording will stop after 30 seconds elapses even if the Stop button is not 
clicked. In that case, just click the [Close] button. 
The following window will appear. 

7 Click the [Sound Format] button as required and select a sound 
format.

8 Edit the sound data so that it conforms to the time limits. 

Adjust the time of the recording with the blue or red switch. 
The extra data outside the starting and finishing switches can be erased by 
clicking the [Cut] button.

To open a sound file already saved to the computer, click the 
[Open] button in place of the [Record] button. Then skip to 
Step 8.

Volume Control

Starting position of 

sound (blue switch).
Play Stop Rewind

Finishing 

position of 

sound (red 

switch)
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9 Click the [Save] tab, confirm that the sound file was created, input a 
file name and then save it. 

10 Click the [Save] button, add a file name and save it.

11 Click  to close the My Camera Sound Maker window. 

12 Click the [Add File] button in the My Camera window.

In the Open dialog, select the file you created and click [Open].
The selected file will appear in the Computer list. 

This concludes the process for adding a file to the My Camera settings. You 
can add the file to the camera with the procedures described in the Saving
the  My Camera Settings to the Camera section (p. 45).

Repeats steps 4-10 as required to create sound files for the 
shutter sound, operation sound and self-timer sound. 

•To delete a setting, select the file name and click the [Delete] 
button at the bottom of the My Computer list. 

•Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono 
sound in the WAV format. The following chart shows 
standard time lengths for My Camera Sounds.

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less



M
a

cin
to

sh
 - P

rep
a

ra
tio

n
s -

51

Using the Software on the 
Macintosh Platform

- Preparations -

This chapter explains the basic procedures for installing the software. Read this 
material before you connect the camera to the computer for the first time.
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Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

•Your computer
•Canon Digital Camera Solution Disk supplied with the camera

Installation Procedures

1 Close any programs that are running. 

2 Place the Canon Digital Camera Solution 
Disk in the computer’s CD-ROM drive.

3 Double-click the CD-ROM icon, followed by 

the [Mac OS X] and [Canon Digital Camera 

Installer]  icons.

With Mac OS 9, double-click the CD-ROM icon, 
followed by the [Mac OS 9] and [Canon Digital 

Camera Installer]  icons.
The installer panel will display automatically.

4 Click [Digital Camera Software Installation]. 

This will start the installation.
Follow the onscreen instructions to proceed with the installation.

Installer Panel
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5 Remove the disk from the CD-ROM drive when 
the installation is complete. 

This concludes the software installation. 
Continue by downloading images to the computer (p. 63). 

See Uninstalling the Software (p. 114) to delete the software 
installed with these procedures.
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Using the Software on the 
Macintosh Platform

- The Basics -

This chapter explains the procedures for using ImageBrowser to download the 
camera's images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software 
on the Macintosh Platform - Preparations - section. 
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Starting ImageBrowser

Begin by starting up ImageBrowser. The startup procedures vary according to 
whether you are connecting the camera to the computer or using a memory 
card reader. 

Camera to Computer Connection

Mac OS X
1 Attach the supplied USB cable to the computer’s USB port and the 

camera’s Digital Terminal. Prepare the camera for communication 
with the computer. 

iPhoto or Image Capture will automatically start when the camera and 
computer are ready to connect. If either of these programs does not start, 
proceed to Step 3.

2 Click  at the upper left of the iPhoto or Image Capture window to 
close it.

3 Double-click the [Canon ImageBrowser] icon on the 
desktop. 

If the Canon ImageBrowser icon does not appear on the 
desktop, double-click the [Canon Utilities] folder on the 
drive on which the program was installed, followed by the [ImageBrowser] 
folder and [ImageBrowser] icon.

4 Click [Canon Camera] in the Explorer View section.

The Communication Settings dialog will display.
This dialog will only appear for the first connection.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 

Explorer View Section
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5 Confirm that [USB port] is selected as the port option and that your 
camera model name or [Canon Camera] are selected as the detected 
camera. Click [Set]. 

iPhoto or Image Capture may automatically start up at the same time as the 
Camera Window. Step 6 is not required when neither program starts up 
automatically. 

6 Click the  icon at the top left of the iPhoto or Image Capture 
window to close the program. 

7 Confirm that the images from the camera are displayed as 
thumbnails (tiny versions) in the Camera Window.

Your camera model 

name or [Canon Camera] 

and the USB port 

number (e.g. @1) will 

appear here.

Thumbnail

Camera Window
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Mac OS 9
1 Attach the supplied USB cable to the computer’s USB port and the 

camera’s Digital Terminal. Prepare the camera for communication 
with the computer.

How to Set ImageBrowser to Start Automatically with Mac 
OS X 
You can have ImageBrowser start automatically when you connect the 
camera to the computer by adjusting the following settings.

Mac OS X v10.2
1. Start Image Capture, click the [Image Capture] menu and select 

[Preferences].
2. Select [Other] from the Camera Preferences list box. 

3. Select [ImageBrowser] in the program selection window.
4. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Mac OS X v10.1
1. Start Image Capture and select [Other] from the Hot Plug Action list 

box.

2. Select [ImageBrowser] in the program selection window.
3. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 



M
a

cin
to

sh
 - Th

e
B

a
sics -

59

ImageBrowser will start and open the ImageBrowser Automation Wizard 
dialog. 

2 Confirm that [Display Images] is selected and click the [OK] button.

The Communication Settings dialog will display.
This dialog only appears the first time the camera is connected.

3 Confirm that [USB port] is selected as the port option and that your 
camera model name or [Canon Camera] are selected as the detected 
camera. Click [Set].

The Camera Window will open and display the camera images as 
thumbnails (tiny versions). 

In the ImageBrowser Automation Wizard dialog, you can 
select the action that is carried out after ImageBrowser 
starts.

Confirm that this 

option is selected.

Your camera model name 

or [Canon Camera] will 

appear here.
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What to Do the Next Time ImageBrowser is Started 
A dialog with the previously selected automated settings will display the 
next time you start ImageBrowser. To use these settings unchanged, 
click the [Start] button. To do nothing, click [Cancel]. To change the 
settings, click [Settings change].

How to Set ImageBrowser to Not Start Automatically
1. Click the Apple menu  and select [Control Panels] and [Canon 

ImageBrowser Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the check 
mark.

3. Click the close box  at the upper left to close the window.

To change the settings, click [Settings Change] and select the desired action in 

the ImageBrowser Automation Wizard dialog.

Click here to close the window.

Clear the check mark here to 

stop ImageBrowser from 

starting automatically.
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Next, download images to the computer (p. 63).

Memory Card Connection

1 Insert the memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling 
instructions.

2 Start ImageBrowser.

Double-click the [Canon ImageBrowser] icon on the desktop.

If the icon does not appear on the desktop, double-click the folder in which 
you installed the program, followed by the [Canon Utilities] and 
[ImageBrowser] folders and the [ImageBrowser] file.

A message asking whether you wish to continue the 
connection may appear after some camera models are 
connected to the computer. See Connection Confirmation 
Message Displays (p. 117) in the Troubleshooting section 
regarding this message.

Place the memory card in an 

adapter if required.
Insert the loaded adapter 

into the slot.

Mac OS X Mac OS 9
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3 Double-click the [DCIM] folder in the Explorer View Section.

The images from the memory card will display as thumbnails in the Camera 
Window. 

Next, download images to the computer (p. 63).

See Memory Card Folder Structure (p. 115) for information 
about memory card folder structures and file names.

Explorer View 

Section
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Downloading Images to the Computer

Creating a Folder to Receive Downloaded Images 

Create a new folder for downloaded images with the following procedures.

1 Click the window labeled [Browser Window] and bring it to the 
foreground.

2 Select the [Users] folder and the subfolder labeled with your user 
name on the startup disk. 

Mac OS 9 users should select [Macintosh HD] in the Explorer View section. 

3 Click the [File] menu and select [New Folder]. 

This will create a folder labeled “Untitled.”

4 Input a new name and press the [return] key.

This will replace the name with the one you type.

Explorer View Section
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5 Select the newly created folder.

Downloading Images

Download images to the new folder.

1 Click the Camera Window to bring it to the forefront.

2 Click the images to download.

A blue frame appears around selected images.

You can select multiple images by holding the [shift] key 
while clicking images.

Thumbnail

The movie icon displays on 

movie thumbnails.

“RAW” displays on RAW images.
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3 Click [Download].

The downloaded images will copy to the computer and appear in the 
Browser Area.

Continue by printing out an image (p. 66).

•You can also download images to the computer by dragging 
them from the Camera Window and dropping them on the 
Browser Area or the Explorer View Section.

•To close the connection to the camera, click the close box  
(Mac OS 9) or the red close box  (Mac OS X) at the top left 
of the Camera Window.

•Your camera uses a standard image transfer protocol called 
the Picture Transfer Protocol (PTP). With the PTP protocol 
and Mac OS X, you can easily download images by 
connecting the camera to the computer with a USB cable 
and using the software preinstalled on your operating 
system, such as iPhoto and Image Capture. (You do not even 
need to install ImageBrowser.) However, there are some 
inconveniences and limitations to this downloading 
method. See the For Windows® XP and Mac OS X Users
leaflet or the Picture Transfer Protocol (PTP) Mode leaflet 
for details. 

“RAW” displays 

on RAW images.

The movie icon 

displays on movie 

thumbnails.

Browser Area
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Printing Images

Printing

1 Select the image(s) you wish to print.

A blue frame appears around selected images.

2 Click the [Print] button and select [Layout printing] from the 
displayed menu.

This displays the Layout Options dialog and the Print window.

3 Confirm that [Custom layout printing] is selected and click [Next].

Movie images cannot be printed. 

Layout Options dialog

Print window
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4 Select settings, such as the paper size, and click [OK].

This will close the Layout Options dialog and allow you to change the 
layout and print settings in the Print window.

5 Adjust the page layout in the Print window if you wish.

See Print Window Features (p. 68) for information about changing layouts.

6 Click the [Print] button in the Print window.

This will display the Print dialog.

7 Click [OK] to start printing.

This concludes the image printing process.

•Selecting the [Custom layout printing] option allows you to 
freely specify the image size and position for printing.

•Selecting an alternative option allows you to print the 
images in an index or in a tiled arrangement.
The [Canon perforated paper printing] option can be 
selected with Mac OS 9.

The settings available in Step 4 will vary according to the 
type of layout selected in Step 3. 

•You can start an index print by selecting [Index printing] in 
Step 2.

•Images shot with Exif 2.2-compliant cameras (Exif Prints) 
incorporate information about the shooting settings, such 
as the camera modes and settings. Better prints can be 
made by using this information to correct the image. You 
can set this function by clicking the [ImageBrowser] menu 
and selecting [Preferences] (in Mac OS 9, click the [Edit] 
menu to select [Preferences]), followed by [Print] in the list 
box and [Image Correction Settings]. 
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Print Window Features

When the [Custom layout printing] option is selected in the Layout Options 
window, you can freely change the size and position of the images for printing.

This chapter explained the ImageBrowser basics. Once you have mastered 
them, read the following chapter to try the advanced techniques.
Using the Software on the Macintosh Platform - Advanced Techniques - (p. 
69) 

A PDF-format manual for ImageBrowser is also available. It 
provides further information about the program's features 
and procedures. See Using the PDF Manuals (p. 109).

Change the Image Size

Drag the border to 

resize the image. 

Change the default 

number of images 

printed per page.

Rotate the selected 

image. 

Reset the layout.

Edit the Page Title

Open the [Edit] menu 

and select [Edit 

Header].

Change the Layout

Drag the images to 

change the layout.

Add Text

Open the [Edit] menu 

and select [Add Text].

Add Captions to Images

Click the image and 

then the [Edit] menu 

and select [Edit 

Caption].

Displays the Layout 

Options window.

Displays the Print dialog.
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Using the Software on the 
Macintosh Platform

- Advanced Techniques -

This chapter explains how to use various ImageBrowser features, such as how to 
play movies, create panoramic images and operate the camera shutter from the 
computer.

Proceed to this chapter once you have mastered the basic ImageBrowser 
procedures in the Using the Software on the Macintosh Platform - The Basics -
chapter.
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Replaying Movies

When you double-click an image with a movie icon in the ImageBrowser’s 
Browser Area, QuickTime Player will start and replay the movie. 

1 Double-click an image with a movie icon. 

QuickTime Player will start. 

2 Click the play button  in QuickTime Player.

The movie will replay.
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Converting RAW Images - File Viewer 
Utility

Images can be recorded in the RAW format (RAW images) with certain camera 
models. RAW images are extremely high-quality images that are not degraded 
by compression algorithms when recorded. However, they are not supported by 
most image editing programs in their native format, so they must be converted 
before use. 
Use the File Viewer Utility to convert RAW images.

Converting RAW Format Images

1 Select a RAW image in ImageBrowser’s Browser Area.

2 From the [File] menu, Select [RAW image Processing].

This will start File Viewer Utility and display the selected RAW image. 

3 Adjust the image quality as required.

See Image Adjustment features (p. 72) for instructions.

4 Click the [File] menu and select [Save File] and [Convert and save in 
file].

This will display the Save File dialog.

5 Select a file destination and format for the image you wish to 
convert.

You can save the image in the JPEG or TIFF format.

6 Click [OK].

The utility will start to convert the image and save it to the computer. 

•See Information about Your Camera (p. 91) to see if your camera 
supports the RAW format.

•See your Camera User Guide for the settings required to shoot 
RAW images. 
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File Viewer Utility Features

Image Adjustment Features

The following items will display when you select a RAW image and a camera 
model name in the Model-Specific Processing Mode list box. You adjust the 
image quality with them.

Save Button

Converts and saves the image.

Preferences Button

Use this button to select 

image transfer 

applications. You can also 

use it to adjust RAW image 

processing settings.

Image Selection Button

Selects the method for 

selecting images. Buttons for 

selecting images. 

Version Information 

Button

Displays the 

program version 

information.

Displays a 

histogram 

(distribution of 

brightness data) for 

the image.

Displays the image 

information here.
Comment Box

A description of up to 60 

characters can be input here.

Display Mode List Box

Selects the thumbnail or 

preview display mode.

Display Size List Box

Selects the size at which images display.

This section displays when a camera model 

name is selected in the Model-Specific 

Processing Mode list box.

Click this button and then a 

white portion of an image 

to automatically adjust the 

white balance to that color. Adjusts the sharpness.

Adjusts white balance settings.

Sets the Photo 

Effect mode.
Adjusts image 

contrast.

Adjusts

image color 

saturation.

Model-Specific Processing Mode List Box

Selects the model of camera in use.
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Merging Panoramic Images - PhotoStitch 

You can create a wide panoramic image by merging several images, such as 
those shot in the camera's Stitch Assist mode.
Use the PhotoStitch program to merge the images.

Starting PhotoStitch 

Start PhotoStitch from ImageBrowser.

1 Select a series of images in the ImageBrowser’s Browser Area. 

2 Click the [Edit] menu and select [PhotoStitch].

A window similar to that below will appear.

3 Merge the images following the instructions in the guidance panel 
at the top of the PhotoStitch window.

Images shot in Stitch Assist mode with a wide converter, 
teleconverter or close-up lens cannot be merged accurately. 

Follow the instructions 

to merge the images.
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Images Shot in Stitch Assist Mode 

It is easy to merge images shot with the camera's Stitch Assist mode since 
PhotoStitch automatically arranges them in the correct order and orientation.
Stitch Assist mode images appear in the Camera Window as shown below. 

•You can also start PhotoStitch by clicking the mark shown on 
images shot in Stitch Assist mode.

•See the Camera User Guide for information about shooting in 
Stitch Assist mode.

Images shot in Stitch Assist mode display a mark 

like this. 
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Operating the Shutter Remotely - 
RemoteCapture
You can use a computer to control the shutter of a connected camera to record 
still images. This is particularly useful for checking images on the larger 
computer display as you record them. 
Start the RemoteCapture program to perform this task.

Starting RemoteCapture 

Start RemoteCapture from ImageBrowser.

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal. Prepare the camera for communication 
with the computer.

2 Close iPhoto or Image Capture if either program has started.

3 Open the lens cover or remove the lens cap on models equipped 
with them. 

Proceed to Step 4 if your model does not have one.

4 Start ImageBrowser.

5 Click ImageBrowser’s [Edit] menu and select [RemoteCapture].

6 Click [Connect] when the "Connect to camera?" prompt appears.

The Communication Settings window will display. This window only 
displays on the first connection.

7 Confirm that [USB port] is selected as the port option and that your 
camera model name or [Canon Camera] are selected as the detected 
camera. Click [Set].

•Close the ImageBrowser Camera Window before starting 
RemoteCapture.

•You cannot use RemoteCapture to shoot while the USB Mounter 
(p. 87) is in use.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 
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iPhoto or Image Capture may automatically start up at the same time. Skip 
to Step 9 if neither program starts up. 

8 Click the  icon at the top left of the iPhoto or Image Capture 
window to close the program.

9 Confirm that the Shooting-RemoteCapture window is displayed.

RemoteCapture Features

RemoteCapture has two windows: the Shooting-RemoteCapture window and 
the Save-RemoteCapture window. Use these windows to record and save 
images, respectively.

Shooting-RemoteCapture Window

RemoteCapture locks the exposure and focus settings for the 
subject matter in the Viewfinder section. If the lighting or 
distance to the subject changes, click [Reflect changes] to reset 
these settings.

Recordable Image Counter

Displays the number of images that will 

fit onto the computer or memory card in 

the camera.

Viewfinder Display

Click the [Viewfinder 

On] button while a 

connection to the 

camera is open to 

display the image 

appearing in the 

camera’s viewfinder. 

Viewfinder On/Off 

Button

Turns the viewfinder 

display on or off.
Reflect Changes Button

Updates the settings.

Slide this to zoom 

the camera in or out.

Set the basic camera 

settings here.

Release Button

Releases the 

shutter.

Detail Settings

The Detail Settings 

dialog opens when 

you click the arrow 

symbol on the left.
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Save-RemoteCapture Window

The following limitations apply when the Viewfinder image is 
displayed with a DIGITAL ELPH/DIGITAL IXUS series camera.
•The Viewfinder will automatically turn off after you shoot or 

after 1 minute passes after it is turned on. Click [Viewfinder On] 
again to turn it back on. However, you may have to wait a 
moment for it to come back on if the camera body temperature 
has risen.

•The camera's LCD monitor does not display while the 
Viewfinder is on. In addition, the Video OUT settings cannot be 
set with RemoteCapture.  

Thumbnail View

Displays thumbnails 

of all the images 

shot after 

RemoteCapture is 

started. 

Connect/Disconnect Button

Click here to open a connection to the camera and 

display the RemoteCapture Shooting window. It will 

change to the Disconnect button while a connection is 

open. Click it to close the connection.

View Button

Displays images 

selected in the 

Thumbnail View 

area at a larger 

size.

Delete Button

Deletes images 

selected in the 

Thumbnail View 

area (completely 

from the computer).

Histogram

Check the distribution of 

brightness data here.

Image Information

Check the image settings here. 

Comments

Add a comment about the 

image here.

Image Display Area

Displays the image 

selected in the 

Thumbnail View.
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Shooting with RemoteCapture

1 Click the arrow to the left of [Detail Setting].

The full-view Shooting-RemoteCapture window will display. 

2 Click [Viewfinder On] and view the image in the Shooting-
RemoteCapture window.

Change the settings if required. To update any changes made in the Detail 
settings window, click the [Reflect changes] button.

3 Set the Size/Quality and Rotation settings in the Shooting-
RemoteCapture window. 

You can save images of people and other subjects that are shot in portrait 
orientation (camera held 90° on end) to the computer in the correct 
viewing orientation by setting the [Rotation] category to [90 degrees left] or 
[90 degrees right].

4 Click the [Release] button. 

Images shot with RemoteCapture are automatically saved to the folder 
selected in ImageBrowser.

If your computer is set to go into sleep mode, there is no 
guarantee that RemoteCapture will continue to function after 
the computer enters sleep mode. Always turn off the sleep 
function before you start shooting with RemoteCapture. 

•The rotation settings in RemoteCapture cannot be used if 
your camera is equipped with the Auto Rotate function and 
it is set to On.

•To change the destination of the saved image, see Changing 
the File Destination and Method of Saving (p.80).

•You can also release the shutter by pressing the camera's 
shutter button or the keyboard's space key.

•The zoom controls and other camera buttons and switches, 
except for the shutter button, cannot be operated while 
RemoteCapture is controlling the camera.

•You may notice that the interval between the shutter 
release and activation is slightly longer when 
RemoteCapture is used to shoot than when the camera is 
used in the normal fashion. 
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Interval Timer Shooting

Interval timer shooting is a method of shooting that records a specified number 
of frames at set intervals. 

1 In the Save-RemoteCapture window or Shooting-RemoteCapture 
window, click the [File] menu and select [Interval Timer Shooting].

This will display the Interval Timer Shooting window.

2 Set the number of frames and the interval value and click [Start]. 

This will record the specified number of frames at the specified interval.

Timer Shooting

Timer shooting is a method of shooting that records a frame after a specified 
number of seconds.

1 In the Save-RemoteCapture window or Shooting-RemoteCapture 
window, click the [File] menu and select [Timer Shooting].

The Timer Shooting dialog will display. 

2 Set the timer interval and click [Start]. 

This will record an image after the specified time has elapsed.

•You can set the time interval between 5 seconds to 60 
minutes 

•You can capture up to the number of recordable frames 
displayed in the Shooting-RemoteCapture window (the 
actual limit is 9999 frames when the displayed number is 
10,000 or higher).

Please note that the camera will not be able to shoot at the 
specified interval if it is shorter than the time required to 
transmit the data and save it to the computer.

You can specify a timer interval from 2 to 30 seconds.
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Other Preferences

Changing the File Destination and Method of Saving
1 Click the [RemoteCapture] menu (Mac OS X) or the [File] menu (Mac 

OS 9) and select [Preferences] in the Save-RemoteCapture or 
Shooting-RemoteCapture window. 

This will display the Preferences dialog.

2 Select the way images are saved and the folder to which they are 
saved and click [OK].

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor. 

1 In the Shooting-RemoteCapture window, click the [File] menu and 
select [Camera Display Settings].

The Camera Display Settings dialog will display.

2 Select [Camera’s LCD monitor] and click [OK]. 

3 In the Shooting-RemoteCapture window, click the [Viewfinder On] 
button. 

Selecting [Computer only] in the "Save Images On" category 
allows you to shoot when there is no memory card in the 
camera or when the camera's memory card is full.

Sets whether images are saved only to the 

computer or to both the computer and the 

memory card in the camera.

Input a root name for the image files here. If 

you input “Capture”, for example, the first 

image will be named [Capture_00001.jpg] 

and successive images will automatically be 

assigned a name that is one number higher 

than the last. 

Select a folder where images will be saved.
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Printing an Index of the Thumbnail Images
You can print an index of all the thumbnails displayed in the Thumbnail View 
area of the Save-RemoteCapture window by clicking the [File] menu and 
selecting [Print Index]. This provides a convenient register and means of 
checking your images since the file name and shooting date are also printed 
with each image.

You can display the subject on a TV connected to the camera 
by selecting [Video Out terminal] in Step 2. See the Camera 
User Guide for instructions to connect the camera to a TV.
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Enjoy Customizing Your Camera with the 
My Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-
timer sound are called the My Camera Settings. You can add your favorite 
images and sounds from your computer to the My Camera Settings in the 
camera. This topic explains how to upload the My Camera Settings saved onto 
your computer to the camera. Use ImageBrowser to perform this function.

Displaying the My Camera Window

To save the My Camera Settings to the camera, you use the My Camera 
window. The following explains the procedures for displaying the My Camera 
window. 

1 The Camera Window will open after you have connected the camera 
to the computer and started ImageBrowser. 

For starting instructions for ImageBrowser, see Starting ImageBrowser (p. 
56).

2 Click [Setup Options] in the Camera Window and select [My Camera] 
in the pop-up menu.

The My Camera Selection dialog will display.

Please check whether or not your camera model supports 
this function. See Information about Your Camera (p. 91) for 
details.
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3 Select [Start-up Image, Start-up Sound, Operation Sound, Selftimer 
Sound and Shutter Sound] and click [OK].

This will display the My Camera window. 

The My Camera Window

ImageBrowser already contains several pre-recorded My 
Camera Settings items. You can check these items with the 
My Camera window.

You can add new files as My Camera Settings to the My Camera 
window. See Adding New Data to the My Camera Window (p. 
85). 

Type

Select the My Camera 

Settings type. 

Displays the list 

of My Camera 

Settings files 

saved onto the 

computer.

Add Button

Click here to add 

a file as one of 

the My Camera 

Settings to the 

My Computer list.

Play Button

Click here to play the 

selected sound setting.

Send to Trash Button

Click here to delete a 

setting from the My 

Computer list. 

Save to Camera Button

Click here to save the 

settings onto the 

camera. 

Delete Button

Deletes a setting 

from the Camera 

list.

Displays the My 

Camera Settings in 

the camera.

Play Button 

Click here to play 

sounds recorded onto 

the camera. 

Save to Camera

Save to Computer 
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Saving the My Camera Settings to the Camera

You can save the My Camera Settings displayed in the My Camera window to 
the camera. 

1 Confirm that the type of setting you wish to save to the camera is 
selected in the Type list box.

2 Select the setting from the Computer list that you would like to add. 

If you selected [Theme] in the Type category, the thumbnail (tiny version) of 
the start-up image will display to the right and the sound files will play in 
the order of start-up sound, shutter sound, operation sound and self-timer 
sound. 

3 Select the setting in the Camera list that you would like to change 
and click the  button.

The Camera list setting will change to the selected file. If a setting for this 
category has previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

4 Click the [Save to Camera] button.

This concludes the process of saving the My Camera Settings to the 
camera. 
To use this data on the camera, change the start-up image and sound 
settings on the camera itself. Please see the Camera User Guide for these 
instructions.

•My Camera Settings can be selected and saved in either of two 
ways to the camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the 
start-up image and animals calls in each of the sound files. The 
names of the prepared files for the various My Camera Settings 
themes all begin with the same root name, such as “Animal~”. 
For example, the start-up image that starts with “Animal~” 
shows an animal picture while the similarly named sound files 
feature animal sounds.

•Settings that do not appear in the My Computer list of the My 
Camera window cannot be saved to the camera. 

•Do not detach the USB cable, turn the camera power off or 
disconnect the camera from the computer while the My Camera 
Settings are being saved to the camera or the settings from the 
camera are being saved to the computer. 
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Saving the Camera’s My Camera Settings to the Computer

The My Camera Settings on the camera can be saved to the computer. 

1 Select the type of setting you wish to save to the camera from the 
Type list box.

2 Select the setting in the Camera list that you wish to save to the 
computer. 

If you selected Theme in the Type category, the thumbnail (tiny version) of 
the start-up image will display to the right and the sound files will play in 
the order of start-up sound, shutter sound, operation sound and self-timer 
sound. 

3 Click the  button.

4 Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera Settings to the 
computer. 

Adding New Data to the My Camera Window

To add new data to the My Camera window, you need to create the new data, 
save it to the computer and add that file to the My Camera window.

Create an Original Start-up Image File and then Add It
Start by creating the image file that will become the start-up image and save it 
to the computer. Use an image editing program, such as ArcSoft 
PhotoImpression. Create the file in the JPEG format at a size of (w) 320 x (h) 240 
pixels.
Once you have created the data and saved it to the computer, use the following 
procedures to add it to the My Camera window.

My Camera Settings can be selected and saved in either of two 
ways to the computer: individually or in theme sets.
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1 Open the My Camera window and click the [Add] button.

This will display the file opening dialog.

2 Select the file you created and click [Open].

The selected file will appear in the Computer list.
This concludes the process for adding new data.
You can save the newly created data to the camera using the procedures 
described in the Saving the My Camera Settings to the Camera section (p. 
84).

Add an Original Sound File
Use a program such as ArcSoft VideoImpression to change the file format to the 
WAV format after you have copied the sound file. Then proceed with the steps 
on the previous page.

To delete a setting, select the file name and click the [Send to 
Trash] button at the bottom of the My Computer list.

•With Mac OS 9, you can use the standard-issue SimpleSound 
program to record a sound file.

•Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono 
sound in the WAV format. The following chart shows 
standard time lengths for My Camera Sounds.

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Downloading Images with the USB 
Mounter

The USB Mounter can only be used with the PowerShot G3, PowerShot S45 and 
PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3 camera models on a computer 
running Mac OS 9.

The USB Mounter is a driver program that allows images on a memory card in a 
camera to be displayed on the desktop as if the camera were a card reader. 
Images can be downloaded to the computer with the same procedures used to 
copy images from a card reader.

Enabling the USB Mounter

To download images with the USB Mounter, first enable it with the following 
procedures.

1 Select [Control Panels] from the Apple menu  and [Canon USB 
Camera Driver].

The Canon USB Camera Driver control panel will display.

2 Select [Card Reader Mode] and close the control panel.

A dialog prompting you to restart the computer will display. 

The following actions cannot be taken while the USB Mounter is 
in use.
•Starting ImageBrowser automatically (when the USB cable is 

connected).
•Using ImageBrowser to adjust camera settings. 
•Shooting with RemoteCapture.
•Deleting images from the camera.
•Uploading images from the computer to the camera. 

Click here to close it.
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3 Click [Yes] to restart the computer. 

The USB Mounter will be enabled.

Downloading Images

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital Terminal.

The camera icon will display on the desktop. 

2 Double-click the camera icon. 

3 Select the folder containing the images. 

The images on the memory card will display as file icons.
See Memory Card Folder Structure (p. 115) for information about memory 
card folder structures and file names.

4 Copy images to the computer’s hard disk using standard file copying 
procedures.

Select images and drag and drop them onto the target folder on the 
computer to download them. 

Disable the USB Mounter when you need to upload images 
to the camera or shoot with RemoteCapture. 

1. Select [Control Panels] from the Apple menu  and 
[Canon USB Camera Driver].
The Canon USB Camera Driver control panel will display.

2. Select [Camera Mode] and close the control panel.
After you restart the computer, the USB Mounter will be 
disabled.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 91) 
for details. 

Never turn off the power or detach the USB cable while 
copying. The equipment may not operate correctly.

Camera Icon

Your camera model 

name will appear here.
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•

When the USB Mounter is enabled, use the card reader 
downloading procedures for ImageBrowser to download 
from the camera. See Memory Card Connection (p. 61).  
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Information about Your Camera

The software package and the procedures for connecting to a computer and 
preparing for data transfers vary between camera models. Certain software 
functions may also not be supported by some camera models. 

Read this section to confirm the capabilities of your camera model. 
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Information Common to All Models

See the respective page for your camera model for information specific to that 
model (pp. 94 - 102).

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all 
models. It contains the following programs.

*1: The WIA Driver is supplied for the PowerShot G3, PowerShot S45 and 
PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3 models only. 

*2: Only compatible with the PowerShot G3, PowerShot S45 and PowerShot 
S230 DIGITAL ELPH/DIGITAL IXUS v3 models.

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ZoomBrowser EX

ImageBrowser

TWAIN Driver

WIA Driver *1

USB Mounter *2

File Viewer Utility

PhotoRecord

PhotoStitch

RemoteCapture
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Connecting the Camera to a Computer

•Your camera and computer
•USB cable supplied with the camera

See the page (pp. 94 - 102) for your specific model for information about 
connecting the camera to the computer.

Ensure that you have installed the software from the supplied 
Canon Digital Camera Solution Disk before you connect the 
camera to the computer. 

•Use the USB cable to attach the camera directly to a USB port on 
the computer, not through a USB hub. The connection may not 
operate correctly through a USB hub.

•The connection may not operate correctly if you are using other 
USB devices, excluding USB mice or keyboards, at the same time 
as the camera. If this occurs, disconnect the other devices from 
the computer and try reconnecting the camera.  

•Do not connect two or more cameras to the same computer via 
the USB interface. The connections may not operate correctly.

•Never allow the computer to go into standby (sleep) mode while 
a camera is connected via the USB interface. If it does happen, 
never disconnect the USB cable. Try to awaken the computer 
with the camera in the connected state. Some computers will 
not awaken properly if you disconnect the camera while they 
are in standby (sleep) mode. Please refer to your computer 
manual for instructions regarding the standby (sleep) mode.

You are recommended to power the camera from a household 
power source (AC adapter) when connecting to a computer. 



PowerShot S5094

PowerShot S50 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

The camera and computer will automatically be ready to transfer data when a 
connection is established.

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 2.0 
See ArcSoft Camera Suite 2.0 CD-ROM (p. 104) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

USB Mounter (Macintosh) is not supported.

USB Port

USB Cable

To the Digital 

Terminal

1. Slip a fingernail under the terminal 

cover and lift to open.

2. Insert it all the way until it clicks.

USB Cable
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PowerShot S400 DIGITAL ELPH/DIGITAL 
IXUS 400 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Set the mode switch to the replay mode and turn the camera’s 
power on. This will prepare the camera to exchange data with the 
computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

•RAW images cannot be recorded.

•USB Mounter (Macintosh) is not supported.

USB Port

USB Cable

To the Digital 

Terminal

1. Slip a fingernail under the 

terminal cover and lift to open.

2. Insert it all the way until it clicks.
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PowerShot SD100 DIGITAL ELPH/DIGITAL 
IXUS II 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Set the mode switch to  and press the ON/OFF button until the 
power lamp lights green. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

•RAW images cannot be recorded.

•USB Mounter (Macintosh) is not supported.

USB Port

USB Cable

To the Digital 

Terminal

1. Slip a fingernail under the 

terminal cover and lift to open.

2. Insert it all the way until it clicks.
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PowerShot A70

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Set the mode switch to the replay mode and turn the camera’s 
power on. This will prepare the camera to exchange data with the 
computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

•RAW images cannot be recorded.

•USB Mounter (Macintosh) is not supported.

USB Port

USB Cable

To the Digital 

Terminal

1. Open the terminal cover by slipping a 

fingernail in the groove and lifting.

2. Insert it all the way until it clicks.



PowerShot A6098

PowerShot A60

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Set the mode switch to the replay mode and turn the camera’s 
power on. This will prepare the camera to exchange data with the 
computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

•RAW images cannot be recorded.

•USB Mounter (Macintosh) is not supported.

USB Port

USB Cable

To the Digital 

Terminal

1. Open the terminal cover by slipping a 

fingernail in the groove and lifting.

2. Insert it all the way until it clicks.
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PowerShot A300

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Press the  (On) button. This will prepare the camera to exchange 
data with the computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

•RAW images cannot be recorded.

•USB Mounter (Macintosh) is not supported.

•The camera's LCD monitor will not display images and the Video OUT 
settings cannot be set while the Viewfinder function is on in the 
Shooting-RemoteCapture window of RemoteCapture.

USB Port

USB Cable

To the Digital 

Terminal

1. Open the terminal cover by slipping a 

fingernail in the groove and lifting.

2. Insert it all the way until it clicks.

USB Cable



PowerShot G3100

PowerShot G3

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Confirm that the camera’s [Communication] setting is set to 
[Normal].

2 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below. 

The camera and computer will automatically be ready to transfer data 
when a connection is established.

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•Adobe Photoshop 5.0 LE 
See Adobe Photoshop 5.0 LE CD-ROM (p. 108) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

All programs and features are supported

See the Camera User Guide for information about the 
camera’s Communication settings.

USB Port

USB Cable

To the Digital 

Terminal

1. Open the terminal cover by slipping a 

fingernail in the groove and lifting.

2. Insert it all the way until it clicks.

USB Cable
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PowerShot S45

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Confirm that the camera’s [Communication] setting is set to 
[Normal].

2 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below. 

The camera and computer will automatically be ready to transfer data 
when a connection is established.

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 2.0 
See ArcSoft Camera Suite 2.0 CD-ROM (p. 104) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

All programs and features are supported

See the Camera User Guide for information about the 
camera’s [Communication] settings.

USB Port

USB Cable

To the Digital 

Terminal

1. Slip a fingernail under the terminal 

cover and lift to open.

2. Insert it all the way until it clicks.

USB Cable



PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3102

PowerShot S230 DIGITAL ELPH/DIGITAL 
IXUS v3

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Confirm that the camera’s [Communication] setting is set to 
[Normal].

2 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below. 

3 Set the mode switch to the replay mode and turn the camera’s 
power on. This will prepare the camera to exchange data with the 
computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk

•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 106) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

•RAW images cannot be recorded.

•The My Camera function is not supported.

See the Camera User Guide for information about the 
camera’s [Communication] settings. 

USB Port

USB Cable

DIGITAL • A/V OUT Terminal

2. Insert the connector with the  symbols on 

the camera and cable aligned.

USB Cable

1. Slip a fingernail 

under the terminal 

cover and lift to 

open.
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Appendices

This chapter introduces the CD-ROMs included in your package and the 
procedures for installing the programs. It also explains how to uninstall the 
programs.

Read the Troubleshooting section in this chapter if you experience a problem 
using the programs.
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About the CD-ROMs in Your Package

CD-ROMs containing image editing programs are included in your camera 
package along with the Canon Digital Camera Solution Disk. This topic explains 
the program features and installation procedures for each CD-ROM.

ArcSoft Camera Suite 2.0 CD-ROM 

This CD-ROM contains the following programs. 

The free hard disk space required to install ArcSoft Camera Suite 2.0 is 250 MB 
or more on a Windows system and 150 MB or more on a Macintosh system.

What Can Be Accomplished with ArcSoft Camera Suite 2.0
Special Effects and Image Editing for Various Purposes

•ArcSoft PhotoStudio
This program can be used to correct colors or brightness levels, apply special 
effects, and edit and print images. ArcSoft PhotoStudio is Arcsoft, Inc.’s high-
performance, user-friendly image editing program.

Programs for Editing Stills and Movies

•ArcSoft VideoImpression
This program provides simple procedures for compiling a movie from multiple 
clips or stills and for editing out unwanted frames from movies.

The CD-ROMs supplied with the cameras differ by model. See 
Information about Your Camera for details (p. 91).

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ArcSoft 
PhotoStudio

ArcSoft 
VideoImpression
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Installing ArcSoft Camera Suite 2.0

Windows 

1 Place the ArcSoft Camera Suite CD-ROM in the drive.

Follow the onscreen messages to install PhotoStudio and VideoImpression.
If the message does not appear automatically, click the Windows [Start] 
menu, select [My Computer], and double-click the [ARCSOFT] and 
[Setup.exe] icons .
Windows 2000, Windows Me and Windows 98 users should double-click 
the [My Computer] icon on the desktop, followed by the [ARCSOFT] and 
[Setup.exe] icons .

Macintosh

•Installing ArcSoft PhotoStudio

1 Close all programs that are running.

2 Place the ArcSoft Camera Suite CD-ROM in the drive.

3 Open the CD-ROM window and double-click the [PhotoStudio 4], 

[English] and [PhotoStudio Installer] icons .

Installation will start.
Follow the onscreen messages to proceed with the installation.

4 Click [Finish] when the message stating that the installation is 
complete appears.

Continue by installing ArcSoft VideoImpression.

•Installing ArcSoft VideoImpression

1 In the CD-ROM window, double-click the [VideoImpression 1.6], 

[English] and [VideoImpression 1.6 Installer] icons . 

Installation will start.
Follow the onscreen messages to proceed with the installation.

2 Restart the computer after the installation is complete.

This concludes the installation process for ArcSoft PhotoStudio and ArcSoft 
VideoImpression.
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ArcSoft Camera Suite 1.2 CD-ROM

This CD-ROM contains the following programs.

The free hard disk space required to install ArcSoft Camera Suite 1.2 is 475 MB 
or more on a Windows system and 375 MB or more on a Macintosh system.

What Can Be Accomplished with ArcSoft Camera Suite 1.2
Special Effects and Image Editing for Various Purposes

•ArcSoft PhotoImpression
This program can be used to apply special effects, and edit and print images in 
simple steps. It can also be used to create postcards and calendars.

Programs for Editing Stills and Movies

•ArcSoft VideoImpression
This program provides simple procedures for compiling a movie from multiple 
clips or stills and for editing out unwanted frames from movies.

Installing ArcSoft Camera Suite 1.2

Windows 

1 Place the ArcSoft Camera Suite CD-ROM in the drive.

Follow the onscreen messages to install PhotoImpression and 
VideoImpression.
If the message does not appear automatically, click the Windows [Start] 
menu, select [My Computer], and double-click the [ARCSOFT] and 

[Setup.exe] icons .
Windows 2000, Windows Me and Windows 98 users should double-click 
the [My Computer] icon on the desktop, followed by the [ARCSOFT] and 

[Setup.exe] icons  .

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ArcSoft 
PhotoImpression

ArcSoft 
VideoImpression
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Macintosh

•Installing ArcSoft PhotoImpression

1 Close all programs that are running.

2 Place the ArcSoft Camera Suite CD-ROM in the drive.

3 Open the CD-ROM window and double-click the [PhotoImpression 

4], [English] and [PhotoImpression Installer] icons .

Installation will start.
Follow the onscreen messages to proceed with the installation.

4 Click [Finish] when the message stating that the installation is 
complete appears.

Continue by installing ArcSoft VideoImpression.

•Installing ArcSoft VideoImpression

1 In the CD-ROM window, double-click the [VideoImpression 1.6], 

[English] and [VideoImpression 1.6 Installer] icons .

Installation will start.
Follow the onscreen messages to proceed with the installation.

2 Restart the computer after the installation is complete.

This concludes the installation process for ArcSoft PhotoImpression and 
ArcSoft VideoImpression.



About the CD-ROMs in Your Package108

Adobe Photoshop 5.0 LE CD-ROM

This CD-ROM contains the following programs

Approximately 40 MB or free hard disk space is required to install Adobe 
Photoshop 5.0 LE.

What Can Be Accomplished with Adobe Photoshop 5.0 LE
Special Effects and Image Editing for Various Purposes 
This program can be used to correct colors or brightness levels, apply special 
effects, and edit and print images. Photoshop 5.0 LE is a limited edition of 
Adobe Systems Inc.’s popular Photoshop program, the standard for image 
editing programs.  

Installing Adobe Photoshop 5.0 LE

Windows

1 Place the Adobe Photoshop 5.0 LE CD-ROM in the computer’s CD-
ROM drive. 

2 Click the [Start] menu, select [My Computer], [Photosle], [English], 

[Photosle] and [Setup.exe] icons . 

For Windows 2000, Windows Me, and Windows 98, double-click the [My 
Computer] icon on the desktop, [Photosle], [English], [Photosle] folder, and 
the [Setup.exe] icon in succession.
Follow the onscreen messages to proceed.

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

Adobe Photoshop 
5.0 LE

You are required to input a serial number when installing Adobe 
Photoshop 5.0 LE. Use [SDM501B4164785-650], or the serial 
number on the CD-ROM case if one is listed there. 
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Macintosh

1 Close any programs that are running.

2 Place the Adobe Photoshop 5.0 LE CD-ROM in the computer’s CD-
ROM drive.

3 Double-click the CD-ROM icon, followed by the [English] and [Adobe 

Photoshop 5.0 LE] folders and the [Install Photoshop LE] icon .  

The installation will start.

Using the PDF Manuals
The following PDF-format manuals (hereafter PDF manuals) are provided 
to explain the features and procedures for using ZoomBrowser EX and 
ImageBrowser.
• ZoomBrowser EX Software User Guide (Windows)
• ImageBrowser Software User Guide (Macintosh)

Adobe Acrobat Reader must be installed to read the 
aforementioned PDF manuals.

Viewing PDF Manuals

Viewing Manuals Downloaded from a Website
These PDF-format manuals are available on the Canon website. Use your 
browser program to download these manuals from the following URL:

http://www.canon.co.jp/Imaging/information-e.html/
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to 
delete the programs from your computer or when reinstallation is required to fix 
corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk 
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a 
program.

1 Click the Windows [Start] menu and select [Programs] or [All 
Programs], followed by [Canon Utilities], [ZoomBrowser EX] and 
[Uninstall ZoomBrowser EX].

The uninstall utility will start and remove ZoomBrowser EX.

•You can remove other programs with the same procedures. 
•PhotoRecord can be uninstalled by clicking the Windows 

[Start] menu and selecting [Programs] or [All Programs], 
followed by [Canon PhotoRecord] and [Uninstall 
PhotoRecord].
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Uninstalling the Other Supplied Programs
•ArcSoft PhotoStudio, PhotoImpression and VideoImpression 

Uninstall these programs by clicking the Windows [Start] menu and selecting 
[Programs] or [All Programs], followed by [ArcSoft Camera Suite] and 
[Uninstall].

•Adobe Photoshop 5.0 LE 
Uninstall the program by clicking the Windows [Start] menu and selecting 
[Programs] or [All Programs], followed by [Adobe], [Photoshop Limited Edition] 
and [Uninstall Photoshop Limited Edition]. 

Uninstalling the USB Driver (Windows)

Use the following procedures to uninstall the USB Driver.

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital Terminal. Prepare the camera for communication 
with the computer.

For USB cable connection instructions, see Information about Your Camera
(p. 91). 
A dialog allowing you to select which application program to start will 
display.

2 Click the [Cancel] button.

If ZoomBrowser EX is started, close it.

It is essential to note that you will not be able to download 
images if you uninstall the USB Driver.  

This procedure is not required with Windows XP for cameras 
other than the PowerShot G3, PowerShot S45 and PowerShot 
S230 DIGITAL ELPH/DIGITAL IXUS v3.
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3 Windows XP: click the [Start] menu and select [Control Panel], 
followed by [Printers and Other Hardware].

Windows 2000, Windows Me and Windows 98 users should click the 
[Start] menu and select [Settings], followed by [Control Panel].

4 Click the [Scanners and Cameras] icon or folder.

5 Delete your camera model name or [Canon Camera] in the [Scanners 
and Cameras] folder.

Windows 2000 and Windows 98 users should delete your camera model 
name or [Canon Camera] in the [Scanners and Cameras Properties] dialog.

Your camera model name or 

[Canon Camera] will appear here.
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Windows XP/Windows Me
Select your camera model name, right-click the mouse and select [Delete].

Windows 2000/Windows 98
Select your camera model name or [Canon Camera] and click [Remove].

6 Click the Windows [Start] menu and select [Programs] or [All 
Programs], followed by [Canon Utilities], [Camera TWAIN Driver x.x]
and [Uninstall TWAIN Driver]. (A version number appears in place of 
the “x.x”.)

Models Other Than the PowerShot G3, PowerShot S45 and 
PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3

• Windows 2000, Windows 98: Perform Step 6 with no substitutions.
• Windows Me: Substitute the following for the underlined portions of 

Step 6.
[Camera WIA Driver x.x], [Uninstall WIA Driver] 

PowerShot G3, PowerShot S45 and PowerShot S230 DIGITAL ELPH/
DIGITAL IXUS v3

Substitute the following for the underlined portions of Step 6.
• PowerShot G3: [PowerShot G3 TWAIN Driver] or [PowerShot G3 WIA 

Driver], [Uninstall TWAIN Driver] or [Uninstall WIA Driver]. 
• PowerShot S45: [PowerShot S45 TWAIN Driver] or [PowerShot S45 WIA 

Driver], [Uninstall TWAIN Driver] or [Uninstall WIA Driver]. 
• PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3: [IXY 320, PowerShot 

S230, IXUS v3 TWAIN Driver] or [IXY 320, PowerShot S230, IXUS v3 WIA 
Driver], [Uninstall TWAIN Driver] or [Uninstall WIA Driver]. 

The uninstall process will start.

To connect the camera to the computer and download after this point, use 
the following procedures.
1. Reinstall the driver.
2. Connect the camera to the computer with the USB cable. 

If your camera model name does not appear here, see the 
Camera not detected, Events dialog won’t display or images 
will not download to the computer (p. 118) of the 
Troubleshooting section.
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Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which 
it was installed) into the Trash.

Please be careful not to accidentally delete any folders with 
downloaded images that may be contained within the 
application folder. 

To learn how to uninstall the USB Mounter, double-click the 
[Canon Digital Camera Solution Disk] CD-ROM icon, followed by 
the [Mac OS 9], [Readme] and [English] folders, and open the 
[Mounter ReadMe] file.
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Memory Card Folder Structure

The images on a memory card are placed in the [DCIM] folder in subfolders 
labeled [xxxCANON], where the “xxx” represents a number in the range 100 - 
998. 

•*Files with the THM extension are the thumbnail image files for the camera’s 
index replay mode.

•**Each successive file shot in Stitch Assist mode is assigned a letter starting 
from “A,” which is inserted as the third digit in the name. i.e. 
[STA_0001.JPG], [STB_0002.JPG], [STC_0003.JPG] ...

•The “xxxx” in file names represent four-digit numbers.
•All folders except the “xxxCANON” folders contain image settings files. Do not 

open or delete them. 

IMG_xxxx.JPG (JPEG format images)

CRW_xxxx.CRW (RAW format images)

CRW_xxxx.THM*

STx_xxxx.JPG** (Stitch Assist mode 

images)

MVI_xxxx.AVI (Movies)

MVI_xxxx.THM*

SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for 

images in the DCIM folder.

The folder created when DPOF settings are set. 

It holds the DPOF settings files.

DCIM

MISC

xxxCANON

CANONMSC



Troubleshooting116

Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer meet the following requirements?

Computer systems that fail to meet the following requirements to 
accommodate a camera connected by a USB cable are not 
supported. Please acquire the necessary system. 
• Built-in USB port on a system pre-installed with Windows XP, Windows 

2000, Windows Me, or Windows 98 (First or Second Edition)
• System with a genuine Apple Computer built-in USB port

Is the camera correctly connected to the computer?

See Information about Your Camera (pp. 94-102) for the correct 
connection procedures. Also check to ensure that you are using the 
correct cable and that it is securely attached at both ends. 

Is the camera’s Communication setting set to [Normal]? (PowerShot 
G3, PowerShot S45 and PowerShot S230 DIGITAL ELPH/DIGITAL 
IXUS v3 only)

Set the [Communication] setting set to [Normal]. See the Camera
User Guide for information about changing communication 
settings.

Is the camera set to the replay mode? (some models only)

Some models require the camera to be set to the replay mode to 
transfer data. See Information about Your Camera (pp. 94-102) for 
details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a 
battery. You are recommended to use a household power source 
(AC adapter) to power the camera when it is connected to a 
computer.
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Problems

Try the suggested solutions to the common problems listed below.

USB Driver installation not proceeding well (Windows)

Uninstall the driver (p. 111) before reinstalling it with the procedures in 
Installing the Software and USB Driver (p. 10). 

Add New Hardware Wizard or New Hardware Found (Windows 
2000) Wizard displays when the camera is connected to the 
computer with a USB cable.

Click [Cancel] to close the window. Temporarily disconnect the camera 
from the computer. Next, read Start by Checking This on the previous page 
and resolve the problem.

Connection confirmation message displays. (PowerShot G3, 
PowerShot S45 and PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3

only)

Cause:

The camera’s [Auto Power Down] function is set to [On]. This 
message displays if you do not access a function for a set period of 
time (5 minutes) while the camera is connected to the computer via 
the USB cable. 

Solution 1:

Select one of the options in the dialog. The connection to the camera will 
close after 1 more minute if you do not act. See the Camera User Guide for 
instructions how to reactivate the camera if this occurs.

Solution 2:

Set the camera’s [Auto Power Down] function to [Off]. See the Camera
User Guide.
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Camera not detected, Events dialog won’t display or images will 
not download to the computer (when camera is connected to the 
computer via a USB cable)

Cause 1:

There is a problem with one of the items in the Start by Checking 
This section (p. 116).

Solution:

Resolve the problem.

Cause 2:

The USB Driver is not installed. (Windows only)

Solution:

Install it with the procedures in Installing the Software and USB Driver (p. 
10).

Cause 3:

The USB Driver is not correctly installed. (Windows only)

Solution:

Uninstall the driver (p. 111) before reinstalling it with the procedures in 
Installing the Software and USB Driver (p. 10).

Cause 4:

The camera may have been recognized as another device under the 
following circumstances. (Windows only)
• The camera was connected to the computer before the USB Driver was 

installed.
• The [Scanners and Cameras] icon or the [Scanners and Cameras] folder 

cannot be found in the [Control Panel] or the [Printers and Other 
Hardware] window.

• Your camera model name, [Canon Camera] or a camera icon does not 
display in the [Scanners and Cameras Properties] dialog or the [Scanners 
and Cameras] folder.

Solution 1:

Start with the following procedures.
Install the USB Driver with the procedures in Installing the Software and 
USB Driver (p. 10). Then connect the camera to the computer with the USB 
cable and prepare it to transfer data (p. 15). If the USB Driver is already 
installed, uninstall it first and then reinstall it.
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Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue 
by implementing the following procedures. The specific steps are explained 
below.
1. Check to see if the camera is being recognized as an “other” device.
2. Delete the driver and the setup information files if it is being recognized 

as an “other” device.
3. Reinstall the driver.

This section explains the specific steps for each operating system.
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Windows XP and Windows 2000 

<Check to see if the camera is being recognized as an “other” 
device and delete the driver if it is.>

1. Windows XP: Click the [Start] menu, followed by [Control Panel], 
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and 
[Control Panel]. Double-click the [System] icon.

2. Click the [Hardware] tab, followed by [Device Manager].
3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 

category. Your camera model name or [Canon Camera] will display in 
these categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera], right-click and 
select [Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

6. Close the [System Properties] window.

Users of Windows XP Professional and Windows 2000 must 
first log in as an Administrator (computer system 
administrator) to delete a driver.  

There are other potential reasons for the problem if the 
“Other devices” or “Imaging devices” categories do not 
appear or your camera model name or [Canon Camera] does 
not appear. Proceed to Step 6, temporarily quit the 
procedures and investigate the other potential causes.

Step 7 and above are not required for Windows XP with 
cameras other than the PowerShot G3, PowerShot S45 and 
PowerShot S230 DIGITAL ELPH/DIGITAL IXUS v3.
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< Delete the setup information files>

7. Windows XP: Click the [Start] menu and open [My Computer], 
followed by [C:] Drive, the [Windows] folder and the [Inf] folder.
Windows 2000: Double-click the [My Computer] icon on the desktop, 
followed by the [C:] drive, [Winnt] folder and [Inf] folder.

8. Look for files for Canon digital cameras that start with [Oem*]. 
The “*” represents a number, such as 0 or 1. 
[Oem*] files come in pairs of [Oem*.inf] and [Oem*.pnf] files. (For 
example, [Oem0.inf] and [Oem0.pnf]). 

9. Double-click the [Oem*] files to check their contents. 
Double-clicking an [Oem*] file will open it in the Windows Notepad 
program. Look for [;***Canon Camera Driver Setup File****] in the 
first line. Note down the names of these files.

If the [Inf] Folder Is Not Visible in the [Winnt] or [Windows] 
Folder
Use the following procedures to show all files and folders.

1. Open the [Winnt] or [Windows] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Files and Folders] category in the Advanced Settings section, 

set [Hidden files and folders] to [Show hidden files and folders]. 
Remove the check marks from the [Hide extensions for known file 
types] or [Hide file extensions for know file types] if it is present.

5. Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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10.Delete the [Oem*] file set.
Delete the [Oem*.inf] and [Oem*.pnf] file for Canon digital cameras 
that you noted down in Step 9.

<Reinstall the driver.>

11.Reinstall the driver with the procedures in Installing the Software and 
USB Driver (p. 10).

Several sets of [Oem*] files may be present in the [Inf] 
folder. Open up each file to confirm that it is an [Oem*] file 
for Canon digital cameras before you do anything with the 
file.

The Inf folder contains numerous files critical to the 
computer’s operation. Be extremely careful to delete the 
correct files. If you delete the wrong files, you may be 
unable to restart Windows.
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Windows Me/Windows 98 
<Check to see if the camera is being recognized as an “other” 
device and delete the driver if it is.>

1. Click the [Start] menu and select [Settings], followed by [Control Panel]. 
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.
3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 

category. Your camera model name or [Canon Camera] will display in of 
these categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera] and click [Remove].
5. Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

6. Click [OK] to close the System Properties window.

< Delete the setup information files.>

7. Double-click the [My Computer] icon on the desktop, followed by the 
[C:] drive, [Windows] folder and [Inf] folder.

There are other potential reasons for the problem if the 
“Other devices” or “Imaging devices” categories do not 
appear or your camera model name or [Canon Camera] does 
not appear. Proceed to Step 6, temporarily quit the 
procedures and investigate the other potential causes. 
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8. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
9. In the [Inf] folder, double-click the [Other] folder to open it.

10. Find and delete the [Canon.IncCAP_xxx.Inf] file. (The xxx 
represents numerals or letters.)
For the PowerShot G3, PowerShot S45 and PowerShot 
S230 DIGITAL ELPH/DIGITAL IXUS v3 models, find and 
delete the [Canon.IncCAP_G3.Inf], [Canon.IncCAP_S45.Inf] or 
[Canon.IncCAP_S230.Inf] file.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

1. Windows 98: Click the [View] menu and select [Folder Options]. 
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
3. Windows 98: Set the [Hide files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show 
hidden files and folders]. 

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.

You do not need to delete anything if none of the above 
files are contained in the [Other] folder.
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<Reinstall the driver>

11.Reinstall the driver with the procedures in Installing the Software and 
USB Driver (p. 10).

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in 
ZoomBrowser EX to slow down or malfunction. If this occurs, set your computer 
display's Hardware acceleration setting to a lower setting. 

1. Click the Windows [Start] menu, followed by [Control Panel] and 
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98, click the [Start] 
menu and select [Settings], followed by [Control Panel]. 

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] 
button and [Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] 
tab, [Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98, click the [Display] icon, followed by 
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

The [Inf] folder contains numerous files critical to the 
computer’s operation. Be extremely careful to delete the 
correct files. If you delete the wrong files, you may be 
unable to restart Windows.



Troubleshooting126

If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with 
Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 4 the titles and comments 
you input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in 
which you installed ZoomBrowser EX 4. (e.g. C:\Program 
Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility.
3. Select the database file you were using up to this point and click the 

[Start] button. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My 
Database.zbd)

This will display the titles and comments input in the earlier versions in 
the comments section of ZoomBrowser EX 4.

If You Had Images in a Folder Below the Program Files Folder
Image files in the [Program Files] folder or a subfolder cannot be displayed 
in ZoomBrowser EX 4 from that location. To display these files, first 
perform steps 1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains 
from the [Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser 
EX\Library One to another location.

The moved folder images can now be selected and displayed with 
ZoomBrowser EX 4.
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A screen like the one below appeared the first time you connected 
the camera to the computer (Windows 98 only)

1 Click [OK].

2 Click the [Browse] button.

The Open dialog will display.

3 Select one of the folders listed below, on the drive where the 
software has been installed.

Select the appropriate folder for your camera model listed below.

Double-click the drive (usually the [C:\] drive) on which you Installed the 
software to display all of its folders and select the appropriate folder.

PowerShot G3 Program Files\Canon\PowerShot G3 TWAIN

PowerShot S45 Program Files\Canon\PowerShot S45 TWAIN

PowerShot S230 DIGITAL 
ELPH / DIGITAL IXUS v3

Program Files\Canon\IXY320 PSS230 
IXUSV3 TWAIN

Double-click the [C:\] 

drive.
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For Example, if your camera is PowerShot G3, double-click the following 
folders in the order [Program Files], [Canon] and [PowerShot G3 TWAIN].

4 Click the [OK] button once you have selected the last folder.

The window in Step 2 will reappear.

5 Click the [OK] button.

The TWAIN driver will install itself automatically.
The Events dialog will display when the installation is complete, allowing 
you to select a program to start. 

Double-click the [Program 

Files], [Canon] and 

[PowerShot G3 TWAIN] 

folders in orders.
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The software installation stops midway through (Windows only)

1 If a message similar the one below appears, click [Finish]. 

2 Display the installer panel.

Refer to How to Display the Installer Panel for instructions (p. 11).

3 Proceed with the operations from Step 4 to Step 8 of the Installing 
the Software and USB driver section (p. 11).

4 Remove the checkmark from [PhotoStitch] when you select the 
software you wish to install and click [NEXT].

After this step is completed, go to Step 10 of the Installing the Software 
and USB driver section (p. 13).

A window similar the one below appeared when you downloaded 
images using ZoomBrowser EX (Windows XP only)

1 Click [Retry].

If the above screen appears again, click [Retry] until it disappears.
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Canon Customer Support
For Canon Customer Support contacts, please see the Canon Limited Warranty supplied with 
your camera.

Adobe Customer Support
Adobe Systems Inc. technical support information is available in the PDF file format on the 

supplied CD-ROM.

PDF File Location and Opening Instructions 

Windows: Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [My 
Computer] icon on the Windows desktop, followed by the [Photosle] CD-ROM 
icon. The window will show folders with language names. Double-click the 

appropriate language folder and the [Support.pdf] file within it.
Macintosh: Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [Adobe 

Photoshop LE] icon on the desktop. Double-click the appropriate language folder 

from among those displayed, followed by the [Support.pdf] file.

• To read PDF files, Adobe Acrobat Reader must already be installed on your computer. An 

installer for this program is on the Adobe Photoshop LE CD-ROM within each language 
folder in a folder labeled [Acroread].

ArcSoft Customer Support
North America 

46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions 

Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.
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